
To do:

Add links to related topics to the features listed in the features topic.

Build Process SDI FTP:

1. Copy the appropriate sdiftp variables to c:\tn3270\help\variables.rtf

1. Open sdiftp.rtf in word, select all and update fields.

1. Open appropriate sdiftp.hpj and compile it.

1. Zip up sdiftp.hlp, sdiftp.cnt

Amendments:
03/12/2002
TN3270 & TN2000: Added version history. 

03/12/2002
Created the following to variables: 
                        FTP— TN3270 Plus FTP, telnet 2000 FTP, SDI FTP
                        Company Name – SDI, telnet software
Created conditional build tags
                    SDIFTP – SDI FTP stand-alone only
                    TN3270PlusFTP – TN3270 Plus FTP only.

03/12/2002
Combined all .rtf files into this 
Made the look and feel similar to TN3270 Plus. (Attached the TN3270 Plus help template)
Added ME and XP operating systems



Overview



TN3270 Plus FTP Help Contents (.cnt) file damaged

The TN3270 Plus FTP help contents file has been damaged or erased, please reinstall TN3270 Plus or send an e-
mail to support@sdisw.com!ExecFile(mailto:support@sdisw.com).
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Introduction

TN3270 Plus FTP is an FTP client application to transfer files between a host system and a user PC. 

With a familiar Windows Explorer-like interface, TN3270 Plus FTP is easy to use for the novice, yet packed full of 
features for the more advanced user.    Designed specifically for the Windows 32-bit environment, the TN3270 Plus 
FTP program package supports the Windows 9x, ME, NT, 2000 and XP operating systems.



Features

Host Support: Supports most known hosts, including IBM Mainframe, AS/400, Unix 
and Windows.

Explorer-like Interface: A familiar Windows Explorer-like interface shows folder and file views 
for both the local and remote computers.

Multiple sessions: Connect up to ten concurrent sessions.
Scripting Language: Use the scripting language to automate common operations. 
Command Line Operation: Allows common operations to be built into command line batch

files.
Upload/Download Options: Optionally upload or download only more recently updated 

files.
Queued File Transfer: Display a real-time progress bar or transfer files quietly in the 

background.
Resume Failed Transfers: Automatically restarts failed file transfers.
Drag/Drop Support: Drag and drop files to upload or download.
Recycle Bin: Full support for the Windows Recycle Bin.
Proxy Server: Supports proxy servers.
Activity Log Files: Maintains a log file for each session.
Automated Installation: An installation wizard leads you through install and uninstall.



Version History 
TN3270 Plus FTP Initial Release Version 2.3, July 2002



Windows and Panes

The TN3270 Plus FTP workspace is divided into several different panes.    At the top is the title bar:

The title bar is followed by the main menu:

Below the main menu may appear a toolbar if the user has selected one from the View menu.

There then appears a set of four panes divided horizontally into two sections.    The section on the left contains two 
panes showing the files and folders on the local computer.    The section on the right holds two panes showing the 
files and folders on the remote, host computer (when connected).    Each section is divided vertically into two panes, 
with the top pane in each section showing the folders and the bottom pane showing the individual files in the currently
selected folder for the active session.

Local Folder Tree Pane (top left)
The pane at the top left shows the drives and folders present on the local computer.    The information is presented in 
a "tree" form, similar to the left-hand pane in Windows Explorer.    Initially, the tree is shown with all branches in a 
"collapsed" state.    A branch may be expanded by clicking on the "+" symbol next to the branch, or by selecting the 
branch and pressing the "+" key on the numeric keypad.    A branch can be collapsed by clicking on the "-" symbol, or 
by pressing the "-" key on the numeric keypad.    If a folder is selected, it becomes the current folder for the active 
session.

Local File List Pane (bottom left)
The pane at the bottom left shows the folders and files present in the currently selected folder on the local computer.   
The information is presented in a "list" form, similar to the right-hand pane in Windows Explorer.    The list is initially 
shown sorted in ascending order by file name.    The list can be resorted in ascending or descending order, by file 
name, size, type or date by clicking on the column heading. 

A single folder or file can be selected from the list by clicking on the item or by using the up and down arrow keys on 
the keyboard.    Multiple folders and files can be selected from the list by clicking on each item while holding down the 
Ctrl key on the keyboard, or by holding down the Ctrl key while using the up and down arrows on the keyboard and 
pressing the space bar.    A folder can be opened by double-clicking the item with the mouse.

Remote Folder Tree Pane (top right)
Once connected to a remote host, the pane at the top right shows the folders present on the remote computer.    
Branches may be expanded and collapsed as with the Local Folder Tree Pane (see above).    

Some of the branches in the tree may show as "??? Unknown".    This occurs when a connection has been made to 
the remote host and the current folder is not the root node on the FTP file system on the remote host.    Expanding the
node will cause TN3270 Plus FTP to inquire about the contents of the parent folder and remove the "??? Unknown" 
node from the tree.

Remote File List Pane (bottom right)
This shows the contents of the currently selected folder on the remote host.    The list can be sorted and items 
selected in the same manner as described for the Local File List Pane (see above).



Output Log Pane
Immediately below the four folder and file panes appears the Output Log pane.    This can be hidden or made visible 
by selecting Output Log from the View menu.    The Output Log pane shows the FTP commands and responses to 
and from the host computer for the currently active session.    Each line appears in a different color as follows:

Green FTP commands sent to the remote host

Blue Normal responses and messages received from the remote host

Red    Error messages received from the remote host

Black Status or informational messages generated by TN3270 Plus FTP

By clicking on the session tabs at the bottom of the output log pane, that session can be made the currently active 
session.

Finally, at the very bottom of the workspace is the status bar.    This can be hidden or made visible by selecting 
Status Bar from the View menu.



Working with Sessions

A "session" is a file on disk containing all the information necessary to connect to a host computer and defining the 
options in use when connected to that host.    Up to ten sessions can be active simultaneously.    

Opening a session
A user can create a new session or open an existing session by using the Connect to Host dialog box.

Switching between sessions
Switch between sessions by clicking on the tab for the session in the Output Log window or by selecting the open 
session number from the View menu.    

Transferring files
Files can be transferred to and from the host computer by a variety of means.    See Transferring Files for more 
information.

Disconnecting a session
You can disconnect a session by either selecting Disconnect from the Host menu or by clicking on the Disconnect 
button on the toolbar.

Reconnecting a session
A session which is in disconnected state may be reconnected either by selecting Reconnect from the Host menu or 
by clicking on the Reconnect button on the toolbar.

Closing a session
A session is closed by selecting Close from the Host menu.



Transferring Files

When a session is connected to a remote host, files can be transferred in one of two directions.    They can be 
"downloaded" from the remote host computer to the local computer on which TN3270 Plus FTP is running. Or they 
can be    "uploaded" from the local computer on which TN3270 Plus FTP is running to the remote host computer.

Downloading Files
1. Select the files or folders you wish to download from the remote host by highlighting them in the Remote File List 

pane.

2. Ensure the download options are set correctly for the transfer.

3. Select Download from the Action menu.

Uploading Files
1. Select the files or folders you wish to upload to the remote host by highlighting them in the Local File List pane.

2. Ensure the upload options are set correctly for the transfer.

3. Select Upload from the Action menu.

Drag and Drop
You can also "drag" selected files from the Remote File List pane to the Local File List pane and vice-versa.

1. Select the files or folders you wish to transfer by highlighting them in the Local or Remote List Pane.    Multiple 
files can be selected by holding down the Ctrl key while clicking on each one with the mouse.

2. Holding the left mouse button down, drag the files to the location in the Local or Remote List Pane where you 
want the files to be transferred.    You can optionally select a sub-folder as the destination at this time.

3. Release the left mouse key.

Quiet Queued Mode
Normally when files are transferred a progress dialog box is shown, giving the current status of the file transfer and 
estimated time remaining.    If the option to transfer in quiet, queued mode is selected on the appropriate Upload or 
Download Properties page, the progress dialog is not shown.    Instead, the files are queued for transfer in the 
background, allowing the user to continue working with other sessions.

To view the current status of queued transfers, select Queues from the View menu.



How To…



Connecting to a Host Computer

1. Open the Host menu and select the Connect command or click the Connect button on the toolbar.

2. Select a previously saved session or fill in the Connect to Host dialog box.

3. Click OK.

Tips:

· You may connect up to 10 sessions. See Working with Sessions for more information.



Navigating Without a Mouse

Although operating TN3270 Plus FTP is considerably easier with a mouse, all the normal functions can be carried out
using a standard keyboard.    



Reference



Command Line Operation

TN3270 Plus FTP can be run from a Command Prompt.    



Script Commands

The following is a list of script commands.

Command Description

! Issue a command in the Windows environment.

? Display a list of valid script commands.

ASCII Set ASCII (text) mode for file transfer.

Auto Set automatic mode for file transfer.

Binary Set binary mode for file transfer.

Bye Close the current session.

Cd Change the current folder on the remote computer.

Close Close the current session.

Delete Delete a file on the remote computer.

Dir Display the contents of the current folder on the remote computer.

Disconnect Disconnect from the remote computer.

Exit Exit from TN3270 Plus FTP.

Get Retrieve a file from the remote computer.

Goto Jump to a label in the script file.

Help Display help information on script commands.

If Evaluate a condition and execute a script command if true.

Lcd Change the current folder on the local computer.

Literal Send a command to the remote computer.

Ls List the contents of the current folder on the remote computer.

Mkdir Create a new folder on the remote computer.

Put Transmit and store a local file on the remote computer.

Quit Close the current session and exit the application if no other sessions are active.

Rename Rename a file or folder on the remote computer.



Rmdir Delete a folder on the remote computer.



! – execute a command in the Windows environment

! {command}

Where:

command is a command to be issued in the Windows environment.

Examples:
!rename test.txt test1.txt

!dir



? – display script commands

Displays a list of valid script commands.



Ascii – set current file transfer mode to ASCII (text)

ascii

Set the current mode for file transfer to ASCII (text).

Example:
ascii



Auto – set current file transfer mode to Auto

auto

Set the current mode for file transfer to automatic.    The transfer mode will be set to text (ASCII) if a file is 
transferred which has a file extension which matches one of the entries in the ASCII Mode File Extension list.    
Entries in the list can be modified by using the Program Options dialog box

.

Example:
auto



Binary – set current file transfer mode to binary

binary

Set the current mode for file transfer to binary.

Example:
binary



Bye – close the current session

bye

Close the current session.    If running from the command line and this is the only active session, bye will also 
exit TN3270 Plus FTP.

Example:
bye



Cd – change the current folder on the remote computer

CD folder

Where:

folder is the folder on the remote computer to be made current for the currently active session.    When the 
change has been made, the new folder is not automatically listed. If the script is being run 
interactively, i.e. not from a command prompt, and the new folder should be listed, use the "ls" 
command to refresh the list of files on the remote computer.

Examples:
cd \

cd pub



Close – close the current session

close

Close the current session.    The application continues running.

Example:
close



Delete – delete a file on the remote computer

Delete filename

Where:

filename is the file on the remote computer to be deleted.

Examples:
delete test.txt



Dir – display the current folder on the remote computer

dir

Refresh the in-storage copy of the contents of the current folder on the remote computer.    When running 
interactively, the contents of the current folder are updated on the screen.

Example:
dir



Disconnect – disconnect from the remote computer

disconnect

Disconnect from the remote computer.

Example:

disconnect



Exit – exit the application

exit {return code | 0}

Exit TN3270 Plus FTP.    Any active sessions will be closed immediately.

Where:

return code is the code returned to the operating system.    If executing TN3270 Plus FTP from the 
command line, errorlevel may be used to check the return code and determine the next 
sequence of events.

Example:
exit 0

exit 99



Get – retrieve a file from the host computer

get {filename}

Where:

filename is the name of the file to be retrieved.

Examples:
get test.txt

get readme.txt



Goto – jump to a label

goto {label}

Where:

label is a label in the script file.    Labels are identified by a colon in column 1.

Examples:
goto next

(other script commands)

:next



Help – display information on script commands

Help    {script command}

Where:

script commandis an optional script command on which to display help information.

Help without any parameters displays a list of script commands available.

Examples:
help

help help

help if



If – evaluate a condition and execute a command if true

if {condition} {script command}

Where:

condition is a condition to evaluate. If this is a numeric value, the TN3270 Plus FTP reply code returned 
from the previous command is evaluated.    If it is equal to or higher than the numeric value, the 
condition is true and the following script command is executed.

script commandis a valid script command.

Example:
If 400 goto end

(other script commands)

:end



Lcd – change the current folder on the local computer

lcd folder

Where:

folder is the folder on the local computer to be made current for the currently active session.    In interactive 
mode, when the change has been made, the new folder is automatically listed.

Examples:
lcd c:\windows

lcd download



Literal – send a command to the remote computer

literal command

Where:

command is the command to send to the remote host computer.    The command is sent verbatim without any 
interpretation.    A one line response is expected.

Examples:
literal    syst

literal    pwd



Ls – display the current folder on the remote computer

ls

Refresh the in-storage copy of the contents of the current folder on the remote computer.    When running 
interactively, the contents of the current folder are updated on the screen.

Example:
ls



Mkdir – create a new folder on the remote computer

mkdir folder

Where:

folder is the new folder on the remote computer to be created for the currently active session.

Examples:
mkdir \newfolder

mkdir subfolder



Put – transmit and store a file on the host computer

put {filename}

Where:

filename is the name of the file to be transmitted to the remote host computer.

Examples:
put test.txt

put readme.txt



Quit – close the current session

quit

Close the current session and exit the application if no other sessions are active.

Example:
quit



Rename – rename a file or folder on the host computer

rename {filename1} {filename2}

Where:

filename1 is the name of an existing file or folder on the remote host computer.

filename2 is the name to which the file or folder will be renamed.

Examples:
rename file1.txt file2.txt

rename newfile.new newfile.old



Rmdir – delete a folder on the remote computer

rmdir folder

Where:

folder is the folder on the remote computer to be deleted.

Examples:
rmdir \oldfolder

rmdir oldfolder



Host Menu

The Host menu contains the following commands:

Connect: Displays the Connect to Host dialog box.

Disconnect: Disconnects the current session.

Reconnect: Reconnects the current session.

Close:      Closes the current session.

Properties: Displays the properties for the current session.

Run Script: Displays the Select Script File dialog box.

Exit: Closes any open sessions and exits TN3270 Plus FTP.



Edit Menu

The Edit menu contains the following commands:

Undo: Negates the effect of the last operation.

Cut: Deletes the file and moves it to the clipboard.

Copy: Copies the selected files to the clipboard.

Paste: Initiates a file transfer of the files currently held on the clipboard.

Delete: Deletes the selected files.    On the local computer a delete operation may move the files to the 
Windows Recycle bin.

Rename: Allows a file to be renamed.

Select All Files: Selects all files in the current window.

Select All: Selects all files and folders in the current window.



Action Menu

The Action menu contains the following commands:

Download: The files selected in the remote host pane will be downloaded to the folder selected in 
the local host pane.

Upload: The files selected in the local host pane will be uploaded to the folder selected in the 
remote host pane. 

Select Transfer Mode: Set the transfer mode for the current session to one of the following:

Automatic: The transfer mode will be set to text (ASCII) if the file being transferred has
a file extension which matches one of the entries in the ASCII Mode File 
Extension list.

Binary: The transfer mode will be set to binary.

Text: The transfer mode will be set to text (ASCII).

Command: Displays the Send Command dialog box.

Stop: Cancels the current remote operation.

New Folder: Creates a new folder in the currently selected pane.



View Menu

The View menu contains the following commands:

Output Log: Shows or hides the output log window.

Status Bar: Shows or hides the status bar.

Toolbar: Shows or hides the toolbar and allows a selection between large or small icons.    

Arrange Icons: Allows entries in the current Local or Remote file pane to be sorted by name, origin (for the 
Recycle bin), size, type or date, in ascending or descending order.

Large Icons: Shows the appropriate large icon for each entry in the current Local or Remote file pane.

Small Icons: Shows the appropriate small icon for each entry in the current Local or Remote file pane.

List: Shows the entries in the current Local or Remote file pane in list form.

Detail: Shows the details for each entry in the current Local or Remote file pane.

Refresh: Refreshes the contents of the currently selected folder or file pane.

Log Files: Shows the files in the log files folder.

Queues: Shows the current status of file transfer queues.

Options: Shows the Program Options dialog box.



Help Menu

The Help menu contains the following commands:

Help Topics: Displays the table of contents for the help file.    This command also gives you access to the help 
index and the help find function.

About TN3270 Plus:    Displays the version number and build date of the application and current licensing 
information.



Connect to Host Dialog Box (Host tab)
Host, Connect, Host tab

Use the following options to specify the host computer:

Session Name: Use the session name to refer to this tailored session for future connections.

Host Name: Enter the host name or IP address of the host computer.

FTP Port: Enter the FTP control port number.    This is normally 21.

User Name: The user name to use to log on to the host computer.

Anonymous: Select anonymous login if the host computer allows a user name of "anonymous" to log in.    
When this box is initially selected, the password will be filled with your email address.

Password: The password to use to log on to the host computer.

Account: The account to use to log on to the host computer.



Connect to Host Dialog Box (Options tab)
Host, Connect, Options tab

The following options can be set:

Local Folder: Specifies the local folder to be displayed in the lower left-hand pane on initial 
connection to the host.    Specify the full path to the folder or use the Browse 
button to select the local folder.

Last Opened Folder: TN3270 Plus FTP will save the name of the folder currently open in the lower 
left-hand pane when the session is closed.

Remote Folder: Specifies the folder on the remote host which will be opened in the lower right-
hand pane following initial connection to the host.

Last opened folder: TN3270 Plus FTP will save the name of the folder currently open in the lower 
right-hand pane when the session is closed.

Refresh folder after changes: The contents of the lower right-hand pane will be refreshed following a 
successful upload, rename or delete operation.

Script File: The name of a script file to be run following a successful initial connection to the
remote host. Specify the full path to the file or use the Browse button to select 
the file.



Connect to Host Dialog Box (Connection tab)
Host, Connect, Connection tab

Use the following options to define how TN3270 Plus FTP should connect to the host computer:

Connection Timeout: Specify the interval in seconds after which the initial connection to the remote host 
computer will be assumed to have failed.

Retry: The number of times following a failure that connection will be attempted.

Data Transfer Timeout: Specify the interval in seconds of inactivity during a data transfer following which the 
transfer will be assumed to have failed.

Proxy Server: Specify the IP address and port number of the proxy server.    



Connect to Host Dialog Box (Download tab)
Host, Connect, Download tab

Use the following options to define how TN3270 Plus FTP should download files from the host computer:

Transfer Sub-folders: If a folder is selected for download, all the files in folders which are contained in 
that folder will be downloaded as well.    The directory structure on the local 
computer will be created to produce a replica of that on the host computer.

Use quiet, queued mode: If this option is set, no progress dialog will be displayed and files will be 
downloaded in the background.    This allows the user to continue working in other
sessions while file transfer takes place.

Download more recent files: Only files which do not exist on the local computer or have a modification date 
which is later than that on the local computer will be downloaded.

Ignore errors: If any error occurs, it will be ignored and the file currently being downloaded will 
be skipped.

Use generated short names: Files stored on the local computer will be renamed according to DOS 8.3 
conventions.    Thus, for example, a file on the remote host computer named "Sort
Work File.wrk" would be stored in a file called "SortWo~1.wrk" when it is 
downloaded to the local computer.



Connect to Host Dialog Box (Upload tab)
Host, Connect, Upload tab

Use the following options to define how TN3270 Plus FTP should connect to the host computer:

Transfer Sub-folders: If a folder is selected for upload, all the files in folders which are contained in that 
folder will be uploaded as well.    The directory structure on the host computer will 
be created to produce a replica of that on the local computer.

Use quiet, queued mode: If this option is set, no progress dialog will be displayed and files will be uploaded 
in the background.    This allows the user to continue working in other sessions 
while file transfer takes place.

Upload more recent files: Only files which do not exist on the host computer or have a modification date 
which is later than that on the host computer will be uploaded.

Ignore errors: If any error occurs, it will be ignored and the file currently being uploaded will be 
skipped.

Use generated short names: Files stored on the host computer will be renamed according to DOS 8.3 
conventions. For example, a file on the remote local computer named "Sort Work 
File.wrk" would be stored in a file called "SortWo~1.wrk" when it is uploaded to 
the host computer.



Program Options Dialog Box (General Tab)
View, Options, General tab

The following application wide options can be set:

Email address: This is used as the password in the Connect to Host dialog box when Anonymous login is 
selected.

Show connection dialog at startup: The Connect to Host dialog box will be shown immediately after the 
application has successfully completed initialization.

ASCII mode file extensions:     ASCII (text) mode will be used to transfer files which have a file extension 
matching one of these entries.    New entries can be added by typing the file extension in the 
edit box and clicking the Add button.    To delete an entry, highlight it in the list box and click the 
Remove button.







Glossary 






